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For Research Use Only. Not for use in diagnostic procedures.

Information in this document is subject to change without notice. Applied Biosystems assumes no responsibility for any errors that may appear in this
document.

APPLIED BIOSYSTEMS DISCLAIMS ALL WARRANTIES WITH RESPECT TO THIS DOCUMENT, EXPRESSED OR IMPLIED, INCLUDING BUT
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SPECIAL, INCIDENTAL, INDIRECT, PUNITIVE, MULTIPLE OR CONSEQUENTIAL DAMAGES IN CONNECTION WITH OR ARISING FROM
THIS DOCUMENT, INCLUDING BUT NOT LIMITED TO THE USE THEREOF.

NOTICE TO PURCHASER: LIMITED LICENSE

A license to perform the patented 5" Nuclease Process for research is obtained by the purchase of (i) both Licensed Probe and Authorized 5 Nuclease Core
Kit, (i) a Licensed 5" Nuclease Kit, or (iii) license rights from Applied Biosystems.

The TagMan® Array Micro Fluidic Card contains Licensed Probe. Use of this product is covered by US patent claims and corresponding patent claims
outside the US. The purchase of this product includes a limited, non-transferable immunity from suit under the foregoing patent claims for using only this
amount of product for the purchaser’s own internal research. The right to use this product in the 5" Nuclease Process under the applicable claims of US
patents, and corresponding patent claims outside the United States, can be obtained through purchase of an Authorized 5" Nuclease Core Kit. Except under
separate license rights available from Applied Biosystems, no right under any other patent claim, or to perform commercial services of any kind, including
without limitation reporting the results of purchaser’s activities for a fee or other commercial consideration, or to sublicense, repackage with other products, or
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Preface

How to Use This Guide

Purpose of This  The Applied Biosystems TagMan® Array Micro Fluidic Cards User Guide provides
Guide information for ordering TagMan® Array Micro Fluidic Cards, preparing and running the
TagMan Array cards on an Applied Biosystems 7900HT Fast Real-Time PCR System,
then analyzing the results.

Audience This guide is intended for novice and experienced 7900HT Fast System users who
perform quantitation experiments with the TagMan Array cards using the comparative Cy
(AACy) method.

Text Conventions This guide uses the following conventions:
* Bold text indicates user action. For example:

Type 0, then press Enter for each of the remaining fields.

 [talic text indicates new or important words and is also used for emphasis.
For example:

Before running, always prepare fresh master mix.

* A right arrow symbol ( » ) separates successive commands you select from a drop-
down or shortcut menu. For example:

Select File » Open.

User Attention Two user attention words appear in Applied Biosystems user documentation. Each word
Words implies a particular level of observation or action as described below:

Note: — Provides information that may be of interest or help but is not critical to the use
of the product.

IMPORTANT! — Provides information that is necessary for proper instrument operation,
accurate chemistry kit use, or safe use of a chemical.

Examples of the user attention words appear below:

Note: There is a fill port on the left arm of each fill reservoir; it is the larger of the two
holes.

IMPORTANT! When performing reverse transcription, do not exceed the amounts of total
RNA recommended in the kit protocol.

TagMan® Array Micro Fluidic Cards User Guide A



Preface
How to Obtain More Information

Safety Alert  Safety alert words also appear in user documentation. For more information, see “Safety
Words  Alert Words” on page x.

How to Obtain More Information

Related In addition to this guide, the TagMan® Array Micro Fluidic Cards User Guide
Documentation (PN 4400263), the documents listed below are available from Applied Biosystems. To
obtain this and additional documentation, see “How to Obtain Support” on page vii.

Title Part Number
Amplification Efficiency of TagMan® Gene Expression Assays 127AP05
Applied Biosystems 7900HT Fast Real-Time PCR System and SDS 4351684
Enterprise Database User Guide
Applied Biosystems 7900HT Fast Real-Time PCR System Relative 4364016
Quantitation Using Comparative Ct Getting Started Guide
Applied Biosystems 7900HT Fast Real-Time PCR System Site Preparation 4351923
Guide
Applied Biosystems Real-Time PCR Systems Reagent Guide 4387787
High-Capacity cDNA Reverse Transcription Kits Protocol 4375575
High Capacity RNA-to-cDNA Kit Protocol 4387951
High Capacity RNA-to-cDNA Master Mix Protocol 4377474
TagMan® Gene Expression Assays Protocol 4333458
TagMan® Gene Expression Cells-to-C;™ Kit Protocol 4385117
TagMan® Gene Expression Master Mix Protocol 4371135
TagMan® PreAmp Master Mix Kit Protocol 4384557
TagMan® Universal PCR Master Mix Protocol 4304449
User Bulletin #2: Relative Quantitation of Gene Expression 4303859
Using TagMan® Endogenous Control Assays to Select an Endogenous 127AP08
Control for Experimental Studies (Application Note)

vi TagMan® Array Micro Fluidic Cards User Guide



Preface
How to Obtain Support

Obtaining The SDS software Help system describes how to use each feature of the user interface. To
Information from  access the Help system, you can:

the Help System | (jick @ in the toolbar

* Select Help » SDS Online Help
* Press F1

To find topics of interest in the Help system, you can:

* Review the table of contents
* Search for a specific topic
» Search an alphabetized index

Send Us Your Applied Biosystems welcomes your comments and suggestions for improving its user
Comments documents. You can e-mail your comments to:

techpubs@appliedbiosystems.com

IMPORTANT! The e-mail address above is only for submitting comments and
suggestions relating to documentation. To order documents, download PDF files, or for
help with a technical question, go to www.appliedbiosystems.com, then click the link
for Support. (See “How to Obtain Support” below).

How to Obtain Support

For the latest services and support information for all locations, go to
www.appliedbiosystems.com, then click the link for Support.

At the Support page, you can:
* Access worldwide telephone and fax numbers to contact Applied Biosystems
Technical Support and Sales facilities
* Search through frequently asked questions (FAQs)
* Submit a question directly to Technical Support

* Order Applied Biosystems user documents, MSDSs, certificates of analysis, and
other related documents

* Download PDF documents
* Obtain information about customer training
» Download software updates and patches

TagMan® Array Micro Fluidic Cards User Guide Vii
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Important Safety Information

This section covers:

B Safety Alert Words . . ... ..o X
B Chemical Safety Guidelines . .............. ..., X
B ADbOUt MDD S . . . xi
B Chemical Waste Safety Guidelines. ... ............. ... ... ... ..., xii
B Waste Disposal . .. ...t e xii
B Biological Hazard Safety . ........... .. ... . . .. xiii
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Important Safety Information

Safety Alert Words

Safety Alert Words

Definitions

Chemical Hazard
Warning

Four safety alert words appear in Applied Biosystems user documentation at points in the
document where you need to be aware of relevant hazards. Each alert
word—IMPORTANT, CAUTION, WARNING, DANGER—implies a particular level of
observation or action, as defined below.

IMPORTANT! — Indicates information that is necessary for proper instrument operation,
accurate chemistry kit use, or safe use of a chemical.

ACAUTION — Indicates a potentially hazardous situation that, if not avoided, may
result in minor or moderate injury. It may also be used to alert against unsafe practices.

AWARNING — Indicates a potentially hazardous situation that, if not avoided,
could result in death or serious injury.

A PN (e]d5] — Indicates an imminently hazardous situation that, if not avoided,
will result in death or serious injury. This signal word is to be limited to the most extreme
situations.

AWARNING CHEMICAL HAZARD. Some of the chemicals used with
Applied Biosystems instruments and protocols are potentially hazardous and can cause
injury, illness, or death.

Chemical Safety Guidelines

To minimize the hazards of chemicals:

* Read and understand the Material Safety Data Sheets (MSDSs) provided by the
chemical manufacturer before you store, handle, or work with any chemicals or
hazardous materials. (See “About MSDSs” on page xi.)

* Minimize contact with chemicals. Wear appropriate personal protective equipment
when handling chemicals (for example, safety glasses, gloves, or protective
clothing). For additional safety guidelines, consult the MSDS.

* Minimize the inhalation of chemicals. Do not leave chemical containers open. Use
only with adequate ventilation (for example, fume hood). For additional safety
guidelines, consult the MSDS.

* Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the
manufacturer’s cleanup procedures as recommended in the MSDS.

* Comply with all local, state/provincial, or national laws and regulations related to
chemical storage, handling, and disposal.

TagMan® Array Micro Fluidic Cards User Guide



Important Safety Information
About MSDSs

About MSDSs

Chemical manufacturers supply current Material Safety Data Sheets (MSDSs) with
shipments of hazardous chemicals to new customers. They also provide MSDSs with the
first shipment of a hazardous chemical to a customer after an MSDS has been updated.
MSDSs provide the safety information you need to store, handle, transport, and dispose
of the chemicals safely.

Each time you receive a new MSDS packaged with a hazardous chemical, be sure to
replace the appropriate MSDS in your files.

Obtaining The MSDS for any chemical supplied by Applied Biosystems is available to you free 24
MSDSs hours a day. To obtain MSDSs:

1. Go to www.appliedbiosystems.com, click Support, then click MSDS Search.

2. In the Keyword Search field, enter the chemical name, product name, MSDS part
number, or other information that appears in the MSDS of interest. Select the
language of your choice, then click Search.

3. Find the document of interest, right-click the document title, then select any of the
following:

* Open — To view the document
* Print Target — To print the document

* Save Target As — To download a PDF version of the document to a destination
that you choose

Note: For the MSDSs of chemicals not distributed by Applied Biosystems, contact the
chemical manufacturer.

TagMan® Array Micro Fluidic Cards User Guide Xi
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Important Safety Information
Chemical Waste Safety Guidelines

Chemical Waste Safety Guidelines

Waste Disposal

Xii

To minimize the hazards of chemical waste:

Read and understand the Material Safety Data Sheets (MSDSs) provided by the
manufacturers of the chemicals in the waste container before you store, handle, or
dispose of chemical waste.

Provide primary and secondary waste containers. (A primary waste container holds
the immediate waste. A secondary container contains spills or leaks from the
primary container. Both containers must be compatible with the waste material and
meet federal, state, and local requirements for container storage.)

Minimize contact with chemicals. Wear appropriate personal protective equipment
when handling chemicals (for example, safety glasses, gloves, or protective
clothing). For additional safety guidelines, consult the MSDS.

Minimize the inhalation of chemicals. Do not leave chemical containers open. Use
only with adequate ventilation (for example, fume hood).For additional safety
guidelines, consult the MSDS.

Handle chemical wastes in a fume hood.

After emptying the waste container, seal it with the cap provided.

Dispose of the contents of the waste tray and waste bottle in accordance with good
laboratory practices and local, state/provincial, or national environmental and health
regulations.

If potentially hazardous waste is generated when you operate the instrument, you must:

L]

Characterize (by analysis if necessary) the waste generated by the particular
applications, reagents, and substrates used in your laboratory.

Ensure the health and safety of all personnel in your laboratory.

Ensure that the instrument waste is stored, transferred, transported, and disposed of
according to all local, state/provincial, and/or national regulations.

IMPORTANT! Radioactive or biohazardous materials may require special handling, and
disposal limitations may apply.

TagMan® Array Micro Fluidic Cards User Guide



Important Safety Information
Biological Hazard Safety

Biological Hazard Safety

&WARNING BIOHAZARD. Biological samples such as tissues, body fluids,

infectious agents, and blood of humans and other animals have the potential to transmit
infectious diseases. Follow all applicable local, state/provincial, and/or national
regulations. Wear appropriate protective equipment, which includes but is not limited to:
protective eyewear, face shield, clothing/lab coat, and gloves. All work should be
conducted in properly equipped facilities using the appropriate safety equipment (for
example, physical containment devices). Individuals should be trained according to
applicable regulatory and company/institution requirements before working with
potentially infectious materials. Read and follow the applicable guidelines and/or
regulatory requirements in the following:

* U.S. Department of Health and Human Services guidelines published in Biosafety in
Microbiological and Biomedical Laboratories (stock no. 017-040-00547-4;
bmbl.od.nih.gov)

* Occupational Safety and Health Standards, Bloodborne Pathogens (29
CFR§1910.1030; www.access.gpo.gov/nara/cfr/waisidx_01/
29¢fr1910a_01.html).

* Your companys/institution’s Biosafety Program protocols for working
with/handling potentially infectious materials.

Additional information about biohazard guidelines is available at www.cdc.gov.

TagMan® Array Micro Fluidic Cards User Guide xiii
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Chapter 1 Introduction

Product Overview

Product Overview

Ab

Notes

out TagMan®
Array Micro
Fluidic Cards

TagMan® Array Micro Fluidic Cards are 384-well cards preloaded with TagMan® Gene
Expression Assays. The TagMan Array cards allow you to measure gene expression
using the comparative C; (AAC;) method of relative quantitation. You can run 1 to 8
samples per card, against 12 to 384 TagMan Gene Expression Assay targets (including
controls). Three types of TagMan Array cards are available from Applied Biosystems:

+ TagMan® Array Custom Micro Fluidic Card — Customizable card—you choose
the assays to include in your card. Select TagMan Gene Expression Assays from
Applied Biosystems collection of Inventoried assays. The TagMan Array Custom
Micro Fluidic Cards are manufactured when ordered.

+ TaqMan® Gene Sets — Customizable card—you choose the assays to include in your
card. The TagMan Gene Sets are a collection of TagMan Gene Expression Assays
that define specific target classes, pathways, or diseases (for example, the TagMan®
Array Human Apoptosis Micro Fluidic Card). Select assays from the TagMan Gene
Sets, then customize the card according to your research needs. TagMan Array cards
with TagMan Gene Sets are manufactured when ordered.

Note: You can substitute assays within a TagMan Gene Set with TagMan Gene
Expression Assays from Applied Biosystems collection of Inventoried assays.

+ TagMan® Gene Signature Array — Preconfigured card. The TagMan Gene
Signature Arrays contain preselected TagMan Gene Expression Assays that target
specific gene classes (for example, Human Stem Cell Pluripotency markers). The
TagMan Gene Signature Arrays are manufactured and placed in inventory.

A complete list of the TagMan Gene Expression Assays that are available for each type of
TagMan Array card can be found on the Applied Biosystems web site. For ordering
information, see Chapter 2 on page 9.

Key Features

* Small-volume design minimizes sample and reagent consumption.
+ Streamlined reaction setup saves time and reduces labor-intensive steps.

* Provides access to high-throughput, 384-well format without liquid-handling
robotics.

e Detects two-fold discrimination at the 99.7% confidence level.
* Provides standardization across multiple samples in multiple laboratories.
For More Information

For more information on relative quantitation, refer to User Bulletin #2: Relative
Quantitation of Gene Expression.

TagMan® Array Micro Fluidic Cards User Guide
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Product Overview

About TagMan®  TagMan Gene Expression Assays are a comprehensive collection of Inventoried and
Gene Expression Made to Order Assays (probe and primer sets) for performing quantitation experiments
Assays on genes from several species.

Note: Only Inventoried Assays can be placed onto a TagMan Array card. If you require a
Made to Order Assay, please contact your local Applied Biosystems Sales
Representative.

The TagMan Gene Expression Assays:
+ Use TagMan® reagents (5’ nuclease chemistry) to amplify and detect the target in
cDNA samples.

* When possible, can amplify target cDNA without amplifying genomic DNA. The
suffix of the assay ID indicates the assay placement (and thus, genomic DNA
detection); see “Detection of genomic DNA During Amplification” on page 33.

+ Consist of two unlabeled primers and one 6-FAM™ dye-labeled, TagMan® MGB
probe

The TagMan Gene Expression Assays are:

» Designed with an automated design system.

+ Designed and optimized to work with an Applied Biosystems TagMan® master mix
using universal thermal cycling conditions.

* Preformulated and ready to use.

Efficiency of TagMan Gene Expression Assays

A statistically significant number of TagMan Gene Expression Assays have been tested
for PCR efficiency. When tested across a 6-log range, all assays approached 100%
efficiency (£10%). Refer to the Application Note Amplification Efficiency of TagMan®
Gene Expression Assays for validation information.

Note: Applied Biosystems does not recommend that you test assay efficiency on the
TagMan Array cards. In order to calculate the efficiency correctly, a dilution series with a
minimum of 5 orders of magnitude must be used. With cDNA samples, in most cases it is
not possible to obtain results over such a large dynamic range, potentially leading to
inaccurate results.

Notes

TagMan® Array Micro Fluidic Cards User Guide 3
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Product Overview

Applications  The TagMan Array cards are recommended for use:

 In relative quantitation experiments using the comparative C; (AAC;) method.

» With singleplex PCR. A single primer/probe set is present in each well of the
TagMan Array card. Only one target can be amplified per well.

* In 2-step RT-PCR:

— In the reverse-transcription (RT) step, you convert total RNA to cDNA. To
perform reverse-transcription, Applied Biosystems recommends the High
Capacity cDNA Reverse Transcription Kit or the High Capacity RNA-to-
cDNA Kit.

— In the PCR step, you combine your cDNA samples and a TagMan® master mix,
add this reaction mix to the TagMan Array card, then run the card on a 7900HT
Fast Real-Time PCR System. The instrument must have a TagMan® Array
Micro Fluidic Card Thermal Cycling Block installed.

During PCR, the 7900HT Fast System detects the real-time amplification of
your targets, then determines relative levels of gene expression from the
fluorescence data that are generated during PCR.

Fill reservoir (1 of 8) — A reservoir for
the sample before it is centrifugally
transferred into the wells. See below
for an enlarged view of the fill
reservorr.

TaqMan® Array
Micro Fluidic
Card Diagram
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Barcode - For each TagMan Array
card, a unique identifier that can be
scanned into database systems for
tracking.

GR2156a

The fill reservoir includes a fill port on the left, and a vent port on the right. Use the fill
port to add reaction mix to the TagMan Array card.
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Instrument Overview

Chapter 1 Introduction ‘I
Instrument Overview

The TagMan Array cards must be:

+ Centrifuged with a Sorvall® or Heraeus centrifuge.
+ Sealed with a TagMan® Array Micro Fluidic Card Sealer, then trimmed.

* Run on an Applied Biosystems 7900HT Fast Real-Time PCR System. The
instrument must have a TagMan® Array Micro Fluidic Card Thermal Cycling Block

installed.

Required

Components
Instrument

Component

Sorvall® or Heraeus
centrifuge

Sorvall/Heraeus Custom Buckets

Card holders

Applied Biosystems 7900HT
Fast Real-Time PCR System

Sequence Detection Systems (SDS) Software v2.1 or later

Note: The SDS software includes a relative quantitation
program. Depending on the SDS software version, it may be
called RQ Manager or AAC; Study.

7900HT TagMan® Array Micro Fluidic Card Upgrade
(hardware upgrade kit):

* TagMan® Array Micro Fluidic Card Thermal Cycling Block
e TagMan® Array Micro Fluidic Card Sealer

e Four centrifuge buckets and card holders (specific to the
Sorvall® or Heraeus centrifuge)

e 7900HT TagMan® Array Micro Fluidic Card Chemical
Installation Kit:

— Spectral Calibration Kit

- TagMan® Array Micro Fluidic Card Instrument
Verification RNase P Kit

— Calibration Cards (4 cards)

Before You Begin Before you perform your quantitation experiment, make sure that:

*  Within the last 6 months, a background run, pure dye runs, and an instrument
performance run (RNase P run) have been performed on the 7900HT Fast System
with the TagMan Array Micro Fluidic Card Thermal Cycling Block installed. For
more information, refer to the SDS Online Help or Applied Biosystems 7900HT Fast
Real-Time PCR System and SDS Enterprise Database User Guide.

* You are familiar with the safety guidelines in the “Safety and EMC Compliance
Information” section of the Applied Biosystems 7900HT Fast Real-Time PCR
System Site Preparation Guide.

* You are familiar with the safety guidelines related to use of your centrifuge, as
provided by the centrifuge manufacturer.

Notes

TagMan® Array Micro Fluidic Cards User Guide
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User Guide Overview

Workflow

Prepare your samples

10 minutes

Prepare the card

Run the card

Analyze the experiment

Notes

Isolate the total RNA

¢

Evaluate the RNA

y.

Perform reverse transcription

Prepare the PCR reaction mix

Y

Add the reaction mix to the card

Y

Centrifuge the card

Seal the card

Set up the experiment
(SDS Software)

¢

Perform the run

¢

Configure the analysis settings
(RQ Study Manager or AACt Study)

¢

Review the results

¢

§T— 3 mRNA

v 3> RT primer

m
=)

3

. 5 CDNA

1m
(=)

(Optional) Perform downstream analysis

For example, TagMan® Gene Expression
Cells-to-C™ Kit

High Capacity RNA-to-cDNA Kit
or
High Capacity cDNA Reverse Transcription Kit

A TagMan® master mix

TagMan® Array Micro Fluidic Card

System software and information CD

7900HT Fast Real-Time PCR System with a
TagMan® Array Micro Fluidic Thermal Cycling Block

System software

il 't,. .\..‘

TagMan® Array Micro Fluidic Cards User Guide



Chapter 1 Introduction ‘I
User Guide Overview

For More
Information Products

For product part numbers and sizes, see Appendix C on page 59.

Documentation

For document titles and part numbers, see “How to Obtain More
Information” on page vi.

Services and Support

For the latest services and support information, see “How to Obtain
Support” on page vii.

Notes

TagMan® Array Micro Fluidic Cards User Guide
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Chapter 2

Order the TagMan® Array
Micro Fluidic Card

This chapter covers:

B Order the TagMan® Array Micro Fluidic Card. ... ........................ 10
B Available Formats . . .. ... .. e 22
B Array Information CD .. ... ... ... . 26
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Order the TagMan® Array Micro Fluidic Card

Order the TagMan® Array Micro Fluidic Card

Order TagMan® Array Custom
Micro Fluidic Cards or TagMan®
Gene Sets (this page).

v

Arrays (page 16).

Order TagMan® Gene Signature

v

Reorder TagMan® Array Custom Micro
Fluidic Cards or TagMan® Gene Sets
(page 19).

Order TagMan® 1.
Array Custom
Micro Fluidic
Cards or
TagMan® Gene
Sets

Go to www.appliedbiosystems.com.

Arrays.

—————————————————————® TagMan® Gene Expression
Assays, Plates & Arrays

® TagMan® MicroRMA Assays

& TagMan® SNP Genotyping
fs5s5ays

® Real-Time PCR Reagents & Kits

® Custom Primers & Probes

& Assays & Custorn Products

2. Inthe I Want to Buy box, click TagMan® Gene Expression Assays, Plates &

3. Under Arrays, click 384-Well Arrays (Micro Fluidic Card).

Gene Expression Assays & Arrays

Which gene expression assay is right for you? Read our
TaqMan® Gene Expression Assays Product Guide (PDF, 1.0

MB).

= Arrays
96-Well Arrays
(Microplate)
—— * 384-Well Armrays (Micro
Fluidic Card)

= Individual Assays

Custom TagMan® Gene
Expression Assays

Expression Assays

= TaqMan® Custom
Plating Service

4. Click TagMan® Custom Array or TagMan® Gene Sets.

384-Well Arrays (Micro Fluidic Card)

= TaqMan® Custom
Array

* TagMan® Gene Sets

= TaqMan® Gene

Signature Arrays
Human ABC Transporter
Array

Human Alzheimer's Array

and Mouse Alzheimer's
Arrav

5. (Optional) On the product page, click the Product Description tab for more
information about the assays and the card layout.

Notes
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6. Click the Ordering Information tab, then click Configure.

Product Description | Literature/Support N

TagqMan® Gene Sets are genes grouped by

Ordering Information

I ‘ pathway or disease target class which can be
ordered separately, as a custom plate, or

—— configured directly onto TaqMan® Arrays

that enable you to perform hundreds of real-
time PCR reactions simultaneously on the
Applied Biosystems 7900HT Fast Real-Time
PCR System. Simple to implement,
TagqMan® Gene Sets are customizable, and
when on a TagMan Array require minimal
amounts of sample, allow for 1 to 8 samples
to be run in parallel against multiple
TagqMan® Gene Expression Assay targets,
and don't require liquid-handling robotics or
complex pipetting.

How to Order

Open the Ordering Guide (4.8 MB) and follow
the steps to add TagMan® Gene Sets to your
shopping basket and check out.

Please Log In to add products to your Shopping Basket/Favorites,
configure a product, or to view products available for purchase in
your country.

O Product Name Part Number Quantity/
Package
B TagMan® Aray LDA 1 cards

Configure

7. On the Store Log In page, enter your user name and password
registered user, click Register Now, then follow the prompts.

. If you are not a

2

Note: If you are already logged in, the Store Log In page does not appear. Go to the

next step.

8. Select a format for your TagMan Array card:

a. Enter a name and description for your card. You cannot enter more than
24 characters for the card name.

b. Select a format. For more information, see “Available Formats” on page 22.

c. Click Next.

Notes

TagMan® Array Micro Fluidic Cards User Guide
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' . Select a Format

Select a Format for your TagMan@® Array, and then dlick Next to proceed. To see a visual representation of a particular array
format, click Wisw Array Layout. Ta see a layout for all array formats in one document, please download the All_Array_Maps pdf(s7Kb).

Name & Describe Your TagMan Array

{ Name * I If you have configured and

saved 2 TagMan Array before,
Description

you can copy, edit, and/or
rearder an existing TagMan
Array design.

Import Saved Design
* Required
Minimum # of 5|
Format | % "Efts Pre-selected Mfg | Maximum # of | ports per sample |  Array Layout
4 BEsE i (8 per array) The TagMan® Array is
compatible with the 7900HT
[ 110 12 1 & {quadruplicates) 1 Wiew Array Layout Fast Real-Time PCR System
with TaqMan® Array block.
Ol 16 15 1 8 (triplicates) 1 Wiew Array Layout
Q| 24 23 1 8 (duplicates) 1 Visw Array Layout
Q| =z 3L 1 4 (triplicates) H wiew Array Layout
8b QO a5 47 1 5 (no replicates) 1 Wisw Array Layout
Q| 64 63 1 2 (triplicates) 4 Wiew Array Layout
O/ s6a 95 1 4 (no replicates) 2 Visw Array Layout
Q| 9sb 95 1 2 (duplicates) 4 wiew Array Layout
Q| 13z 151 1 1 (duplicates) [ Wisw Array Layout
Q| 384 380 4 1 (no replicates) 8 Wiew Array Layout

N @——7C

9. Choose your assays and controls:

a. Search for assays using one of the following options:

* Click Search by Keyword to display search options. Enter a keyword,
select a category, (optional) select additional search criteria (for example,
species), then click Search. When the search results are returned, select
your assays, click Add to Card, then click Return to Configurator.

* Click Search by Batch ID to display search options. Enter or upload a
batch of assay IDs, (optional) select additional search criteria (for
example, species), then click Search. When the search results are
returned, select your assays, click Add to Card, then click Return to
Configurator.

Note: You can place assays from more than one species on the same TagMan
Array card.

(Recommended for the TagMan Gene Sets) Click Select a Gene Panel to
display a suggested list of gene panels. Select your gene panels, click Add
panels to Card, then click Return to Configurator.

Note: For more gene panels, go to:
www.appliedbiosystems.com/tools/workflow/.

b. Choose the endogenous controls for your experiment, using any of the search
options described in step a above.

Note: Applied Biosystems recommends that you use the TagMan®
Endogenous Control Assays to select your endogenous controls. For more
information, see Appendix B on page 57 and refer to the Applied Biosystems
Application Note Using TagMan® Endogenous Control Assays to Select an
Endogenous Control for Experimental Studies.

TagMan® Array Micro Fluidic Cards User Guide
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Section 2

c. Review the gene symbols added to your TagMan Array card. If needed, you
can:

* Repeat step a above to add more assays/panels to the card.
* Select a gene symbol, then click Remove to remove assays/panels from
the card.

d. In the Manufacturing Controls box, select a gene symbol from the dropdown
menu.

Note: The well locations for the controls are predetermined, based on the
TagMan Array card format you selected in step 8 on page 11.

e. Click Next.

9c
G Praious Next @
3 ways to sea rch for and » Gene Symbol Assay ID Al | Array Details
choose assays: I BMP1D Hs00205566_m1 Name Test
« Search by Keyword [ BMPRZ Hs00176148_m1 Format Format 96a
QOa- Seerch by gene symbel, gene [ GDF10 Hs00192033_m1 Assigned Wells 95

name, publc accession rumber, [ sMaDL Hs00195432_m1 Empty Wells 0
biological process, molecular -
function, and more. [ sMaD9 Hs00195441_m1 Unique Genes 94

[ sp1 Hs00293689_s1 .

Manufacturing Controls
. Search by Batch ID [ TGFBR2 Hs00559661_m1 i
Gene Symbol Location

Search by uploading  file [ AcvRl Hs00153836_m1 9d
cortaining multiple assay 1Ds, ! - 00745761 51 185 TRNA [ s
RefSeq accession numbers, s S
GenBark 31 #s, LocusLink IDs,

[ ToFB1 Hs99999918_m1
gene symbols, IMAGE Clone IDs, ¢ -m j
or speacies. R A .
« Select a Gene Panel
Select from expertly pre-defined
gene panels corresponding to &
biological pathway or target class.

Remove — QC

G Praiious Newt @——— 9e

10. (Optional) Customize the TagMan Array card layout:

a. To change the location of the assays in the card, use the up/down arrows or
enter the desired well location.

Note: If you change the well location for one replicate, all other replicates are
moved accordingly.

Note: The well locations for the controls are fixed, based on the TagMan Array
card format you selected in step 8 on page 11.

Notes
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b. Click Update Array Layout.

Note: To return to the previously saved layout, click Reset Layout.

c. Click Next.
:

You can change the location of assays using the up and down arrows in the Move column. Note that the lacations for manufacturing
contrals are fixed

Skip this Step & Previous Next @

v m BMP10 Hs00205566_m1 s Test
. Format Format 96a
. BMPR2 Hs00176148_m1
Assigned wells | 95
- GDF10 Hs00192033_m1 Empty wells 0
Unique Genes | 94
10a ] SMAD1 Hs00195432_m1
Manufacturing Controls
o SMADO Hs00195441_m1 _
Gene Symbol Location
N
o sP1 Hs00293689_s1 185 rRNA A1l
= 407 | TGFBR2 Hs00559661_m1
[~
10— T Gpaate array Layout | [Reset Layout |
[T TelalelslelzTolelolal=]-
BMP10 BMPR2 | GDF10 | SMAD1  SMADS | SPL | TGFBR2 | ACVRL | LEFTY2 | TGFB1 | 185 | SMAD3
H FsT BMPE | ZFYVES SMADS | PPP2CB | MSTM  ROCKL | GDF3 | E2FS | GDFLS SKP1
ACVRLE EP00 | STUBL | I6 IL17F | INHBB | HIPKZ | E2F4 | INHBC = SMADZ | BMPZ | ACWRZA
ﬂ TGFEBRAPL | RPSEKBZ = MAPKZ | TFDP1 | TGFBRZ | CULL  GAPDH | SMAD4  DON B2M | RHOA | SMADS
£ [EEUEH BMPRZ | GDF10 | SMAD1  SMAD3 | SPL  TGFBR2 ACVRL | LEFTY2 TGFEL 185  SMAD3
FST BMP3 | ZFYVES  SMADS | PPPRCB | MSTM  ROCKL | GDF3 | EBFS | GDFLS skpt ¥
4 »
e —— : g
Skip this Step @ Previous Next @———— 1 OC

11. (Optional) Use one or more of the configuration tools:

» Click Save This Design to save your current TagMan Array card design to the
Applied Biosystems store workspace. If your design is successfully saved, this
message appears at the top of the page:

You have successfully added your design to workspace.

Note: For more information on the Applied Biosystems store workspace, click
the workspace link shown in the message.

* Click Export Assay List, then follow the prompts to export a list of your
current assays to a simple text application (*.txt file).

* Click Print Array Layout, then select File » Print to print your current
TagMan Array card layout.

Notes
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OrderingInformation | Product Descrigtion | Literature/Support Related Products Configure

Configuration
Tools

Compatible

i Save This Design @ Export Assay List = Print Array Layou Instruments

- Select a
ny Format 4

n - Choose Assays v
- & Controls

n, Customize Array )
" Layout (optional)

i @ Review & Order

12. Review and order your TagMan Array card:

a. Review the card details. If needed, click Previous to change the information.

b. Enter the quantity of cards to order. The minimum quantity you can order is
10 cards.

Note: After the minimum quantity has been fulfilled, you can order TagMan
Array cards in increments of one.

c. Select your basket from the dropdown menu.

il (@) Review & Order

G Previous
Array Details
Name Test
Description
Format Format 96a
12a — Species Selected Homo sapiens
Assigned Wells 95
Unique Genes 94
Empty Wells 0
Control Assays 185 rRNA
S*elect Package Quantity 10| (Hinimm quentity of 0)
12b ‘
* Required Field
[ My Bsket05/20/200 _vA Add to Basket
12¢
12d GPIE‘\"MU571 2a

Trademark

TagMan® Array Micro Fluidic Cards User Guide 15
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Order the TagMan® Array Micro Fluidic Card

d. Click Add to Basket. You can:

* Repeat step 8 on page 11 through step 12 on page 15 to continue ordering

TagMan Array cards.

* Click Shopping Basket to check out.

Your order was successfully added to your Shopping Basket.

Applied Biosystems ships the TagMan Array cards at ambient temperature. Upon receipt,
store the cards at 2 to 8 °C. The cards are stable for up to 2 years from the manufacturing

date.

Order TagMan® 1. Go to www.appliedbiosystems.com.

Gene Signature

Arrays
y Arrays.

2. Inthe I Want to Buy box, click TagMan® Gene Expression Assays, Plates &

I Want to Buy... :

® TagMan® Gene Expression
Assays, Plates & Arrays

@ TagMan® MicroRMA Assars

® TagMan® SNP Genotyping
Assays

® Real-Time PCR Reagents & Kits

@ Custorn Primers & Probes

® Assays & Custorn Products
b,

3. Under Arrays, click 384-Well Arrays (Micro Fluidic Card).

Gene Expression Assays & Arrays

Which gene expression assay is right for you? Read our
TaqMan® Gene Expression Assays Product Guide (PDF, 1.0
MB).

= Arrays = TagMan® Custom
96-Well Arrays Plating Service
(Microplate)
384-Well Arrays (Micro
Fluidic Card)

= Individual Assays
Custom TagqMan® Gene
Expression Assays
TaqMan® Endogenous
Control
TaqMan® Gene
Expression Assays

4. Click TagMan® Gene Signature Arrays.

384-Well Arrays (Micro Fluidic Card)

= TagMan® Custom

= TagMan® Gene ———————

Array Signature Arrays
Human ABC Transporter
= TaqMan® Gene Sets Array

5. Onthe TagMan® Gene Signature Arrays page, select the appropriate Gene Signature

Array.

Notes
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6. (Optional) On the product page, click the Product Description tab for more
information about the assays and the card layout.

7. Click the Ordering Information tab.

8. Login:

a. Click Log In.

Note: If you are already logged in, the Log In prompt does not appear. Go to
the next step.

b. On the Store Log In page, enter your user name and password. If you are not a
registered user, click Register Now, then follow the prompts.

Product Description 1 Literature/Support 1

The TaqMan® Human ABC Transporter Array

contains assays for 50 human genes in

addition to 14 endogenous controls in a 384-
e — well array.

Ordering Information

| - . .
Please Log In to add products to your Shopping Basket/Favorites,
configure a product, or to view products available for purchase in
your country.

O Product Name Part Number Quantity/
Package
O TaqMan® Human ABC 4378700 4 cards

Transporter Array

Note: See user's manual or package insert for limited label
license, and trademark information. For Research Use Only. Not
for use in diagnostics procedures.

Tracdemark

9. Order your TagMan Array card:

a. Select the card.

b. Select your basket from the dropdown menu.

Notes

TagMan® Array Micro Fluidic Cards User Guide
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Ordering Information Product Description Literature/Support |

The TaqMan® Human ABC Transporter Array
contains assays for 50 human genes in
b addition to 14 endogenous controls in a 384-

S — well array.

You can view your contract pricing for products in your Shopping
Basket or Favorites.

—
My Basket11/2 | [ CERLNE
Add to Favorites

List @
. Price
O/ Product Name Part Number Quantity/ [View
Package
Your
Price]
(o)
Ja TaqMan@ 4378700 4 cards
Human ABC
Transporter
Array
T
9b My Basket11/z v | [ CERENEE O

Add to Favorites
9c

Note: See user's manual or package insert for limited label
license, and trademark information. For Research Use Only. Not
for use in diagnostics procedures.

Trademark

c. Click Add to Basket. You can:

* Repeat step 3 on page 16 through step 9 on page 17 to continue ordering
TagMan Gene Signature Arrays.

* Click Shopping Basket to check out.

Your order was successfully added to your Shopping Basket.

Applied Biosystems ships the TagMan Array cards at ambient temperature. Upon receipt,
store the cards at 2 to 8 °C. The cards are stable for up to 2 years from the manufacturing
date.

Notes
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Reorder TagMan®  There are two ways to reorder the same TagMan® Array Custom Micro Fluidic Cards or
Array Custom TagMan® Gene Sets:

Micro Fluidic * Import a saved design from within the Configurator (this page) — To use this

Cgrds or method, you must have previously saved a design (step 11 on page 14) or added an
TagMan G'Sene order to your shopping basket (step 12 on page 15).
ets

Note: You can use this method if you have not yet submitted the order (that is, you
added the order to your shopping basket, but did not check out).

* Reorder from your shopping basket (page 21) — To use this method, you must have
previously submitted an order (step 12 on page 15).

Import a saved design
1. Go to www.appliedbiosystems.com.

2. Inthe I Want to Buy box, click TagMan® Gene Expression Assays, Plates &
Arrays.

® TagMan® Gene Expression
Assays, Plates & Arrays

@ TagMan® MicroRMA Assars

® TagMan® SNP Genotyping
Assays

® Real-Time PCR Reagents & Kits
@ Custorn Primers & Probes
® Assays & Custorn Products

3. Under Arrays, click 384-Well Arrays (Micro Fluidic Card).

Gene Expression Assays & Arrays

Which gene expression assay is right for you? Read our
TaqMan® Gene Expression Assays Product Guice (PDF, 1.0
MB).

Arrays TaqMan® Custom
96-Well Arrays Plating Service
(Microplate)

—  384-Well Arrays (Micro
Fluidic Card)

Individual Assays
Custom TagqMan® Gene
Expression Assays
TaqMan® Endogenous
Controls

TaqMan® Gene
Expression Assays

4. Click TagMan® Custom Array or TagMan® Gene Sets.

384-Well Arrays (Micro Fluidic Card)
I

—— = TagMan® Custom
Array

— = TaqMan® Gene Sets

Notes

TagMan® Array Micro Fluidic Cards User Guide
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5. On the product page, click the Ordering Information tab, then click Configure.

Ordering Information Product Description Literature/Support |

TagqMan® Gene Sets are genes grouped by
pathway or disease target class which can be
R ordered separately, as a custom plate, or
f\,e — configured directly onto TaqMan® Arrays
that enable you to perform hundreds of real-
time PCR reactions simultaneously on the
Applied Biosystems 7900HT Fast Real-Time
PCR System. Simple to implement,
TagqMan® Gene Sets are customizable, and
when on a TagMan Array require minimal
amounts of sample, allow for 1 to 8 samples
to be run in parallel against multiple
TagqMan® Gene Expression Assay targets,
and don't require liquid-handling robotics or
complex pipetting.

How to Order

Open the Ordering Guide (4.8 MB) and follow
the steps to add TagMan® Gene Sets to your
shopping basket and check out.

Please Log In to add products to your Shopping Basket/Favorites,
configure a product, or to view products available for purchase in
your country.

O Product Name Part Number Quantity/
Package
U TagMan® Array LDA 1 cards
Configure

6. On the Store Log In page, enter your user name and password.

Note: If you are already logged in, the Store Log In page does not appear. Go to the
next step.

7. Instep 1 of the Configurator, click Import Saved Design.

Ordering Information Product Description Literature/Support Related Products Configure ]

Configuration Import Saved 0 Compatible
Tools Design Instruments

il @ Select a Format

Select a Format for your TaqMan® Array, and then click Next to proceed. To see a visual representation
of a particular array

format, click View Array Layout. To see a layout for all array formats in one document, please download
the All_Array_Maps.pdf(57Kb).

Name & Describe Your TagMan Array

Name *

Description

* Required

Notes
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On the Designs page, click the name of the design you want to import. You are
returned to step 4 of the Configurator (Review & Order).

Designs topor: R

Design files for Tagman® Arrays and SHNPlex™ are stored and
summarized below. Your total workspace storage limit for both
Designs and Saved Lists is 10000KB. Design files are automatically
deleted if they have not been used after 12 months.

- Select filter criteria from Display pull-down lists to see results. Sort
columns using header arrows.

- Open a design by clicking on the name, which returns you to the
Configurator.

- To Edit, Copy or Export, click one design’s corresponding box at the
left, then use the button on the right of the row. Edit allows you to
name, rename and describe your file. Exported files may only be
uploaded if they are SNPlex encrypted files with the .enc file
extension, using File Upload on the upper right.

- Organize your files by creating Projects using the Project column
Edit link.

- To delete one or more designs, check the corresponding box(es),
and then click Delete.

) ) S | i
Indicates parent/child relationship: Parent ’ Child

pisplay:: ETETY [ All Project ~

O Test_o Configuration | Pending = 2009-01-26 | Edit | order
12609 11:48:51.0 - —
| Copy

Delete Previous | Next

In the Configurator, review and order the TagMan Array card according to step 12
on page 15, or click Previous to make changes.

Reorder from your shopping basket

1.
2.

Notes

Go to www.appliedbiosystems.com.

At the top of the Home page, from the My Baskets/Orders dropdown menu, select
Order History/Reorder.

AR 8BS | o
D Biosystems = uUnited states © StarLegout (94 My Account = My Baskatsiordars = (0] Quick order
Wiew My Basket
Home Products Applications & Technologies Services Support (RETOIL 17anace Shopping Baskets
Crder History/Raardar
Welcome Laurie Swenson, [Not Laurie Swenson?] Enter search term Favorites {b 2] - |

Promations/Quotes

warkspace

On the Store Log In page, enter your user name and password.

Note: If you are already logged in, the Store Log In page does not appear. Go to the
next step.

Select the TagMan Array card to reorder, then click at the top-right of the
page.

TagMan® Array Micro Fluidic Cards User Guide 21
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Available Formats

The table below provides a list of available TagMan® Array Micro Fluidic Card formats
for selected TagMan® Gene Expression Assays. Illustrations of each format follow.

No. of Minimum Mandatory Maximum No. of Minimum No. of
Format Part No. Target Order Manufacturing Samples per C ard Ports per Sample
Assays No.* Controls ples p (8 per card)
12 4342247 11 10 1 8 (quadruplicates) 1
16 4346798 15 10 1 8 (triplicates) 1
24 4342249 23 10 1 8 (duplicates) 1
32 4346799 31 10 1 4 (triplicates) 2
48 4342253 47 10 1 8 (no replicates) 1
64 4346800 63 10 1 2 (triplicates) 4
96a 4342259 95 10 1 4 (no replicates) 2
96b 4342261 95 10 1 2 (duplicates) 4
192 4346802 191 10 1 1 (duplicates) 8
384 4342265 380 10 1 (4 replicates) 1 (no replicates) 8
I After the minimum quantity has been fulfilled, you can order TagMan Array cards in increments of one.
Format 12 11 target assays + 1 mandatory manufacturing control
8 unique samples
Replicates Port
1 [ 99 | A
414 5 g 5
2 c2
3 K
4 Lo
5 s
6 G
7 R
8 o8

1 2 3 4 5 6 7 8 9 10 " 12 13 14 15 16 17 18 19 20 21 22 23 24

Notes
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Format 16 15 target assays + 1 mandatory manufacturing control

8 unique samples

Replicates Port

A

1 1
8|8 |8 0 0 0 B
C

2 2
D
E

3
8 F
G

4
4 H
|

5 5
J
K

6 6
L
M

7 7
N
o

8
8 P

1 2 3 4 5 6 7 8 9 0V n 12 13 14 15 16 17 18 19 20 21 22 23 24

Format 24 23 target assays + 1 mandatory manufacturing control

8 unique samples

Replicates Port
1 10 [ert] 1 13 A
N 2> SN 4+ WEN o WA s [ON 1o [cTi| 11 2N 13 [N 15 [NGN 17 [NEN B
2 g 2
3 3
4 : 4
5 L 5
6 f 6
7 “N” 7
8 g 8
1 2 3 4 5 6 7 8 9 10 n 12 13 14 15 16 17 18 19 20 21 22 23 24
Format 32 31 target assays + 1 mandatory manufacturing control
4 unique samples
Replicates Port
A
1 8 8 8 0 0 0 4 4 4 B
ST c
6 6 6 8 8 8 0 0 0 D
K
2
C 4
o
|
3 ;0
K
Cs
M
4 T
O g
P

Notes
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Format 48 47 target assays + 1 mandatory manufacturing control

8 unique samples

Replicates Port
1 A
B
2 C
D
E
3 ; 3
G
4 " 4
|
5 ) 5
K
6 . 6
7 M7
N
[e]
8 B 8
1 2 3 4 5 6 7 8 9 0 1 12 13 14 15 16 17 18 19 20 21 22 23 24
Format 64 63 target assays + 1 mandatory manufacturing control
2 unique samples
Replicates Port
A
8 8 8 0 0 0 B !
TR c
1 4 4 4 6 6 6 8 8 8 0 0 0 D 2
SEslEcIn
0 0 0 4 4 4 4 4 46 | 46 | 46 F 3
STRE <,
8|58 |58 60 | 60 | 60 6 6 6 H
L
J
G
2 M
7
N
o 8
;
1 2 3 4 5 6 7 8 9 0 1 12 13 14 15 16 17 18 19 20 21 22 23 24
Format 96a 95 target assays + 1 mandatory manufacturing control
4 unique samples
Replicates Port

A

B

L C

D
K

2 G
4

o
J‘5

3 K
6

L
“N”7

4 [e]
8

P

Notes
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Format 96b 95 target assays + 1 mandatory manufacturing control

2 unique samples

Replicates Port
10 [CTL| 11 13 15 17 19 21

Tv|Oo|Z|Z|r|AR|«|—|T o|mnm|Oo

Format 192 191 target assays + 1 mandatory manufacturing control

1 unique sample

Replicates Port

17 19 21
17 19

103 105 107 109 m 13 115 17
101 103 105 107 109 111 13 115 17
124 126 128 130 132 134 136 138 140
124 126 128 130 132 134 136 138 140
147 149 151 153 155 157 159 161 163
147 149 151 153 155 157 159 161 163 165
170 172 174 176 178 180 182 184 186 188
170 172 174 176 178 180 182 184 186 188 190
1 2 3 4 5 6 7 8 9 0 n 12 13 14 15 16 17 18 19 20 21 22 23 24

Format 384 380 target assays + 4 mandatory manufacturing controls

1 unique sample

Replicates Port

Notes

TagMan® Array Micro Fluidic Cards User Guide 25



2 Chapter 2 Order the TagMan® Array Micro Fluidic Card

Array Information CD

Array Information CD

SDS Setup File

[ [il2]s[4[5[e[7[8]a] Setup | nstrument |
. EEEEEEN A wele): a1 7]
I
= [Sample Name: Sample0l Sample Mame: [Sampledt
U= Detectors: il
0 M |0 TR 1500000003 _m1 - Target Ve Detectar ity AEEH
™ T TB5-H=03000801 _s1 A
= ACTE-Hs99999903_m1 A Target
The SDS EEEEEEEN r ACTC-HS00B0E316_m1 A -
ft EEEEEEEEN r AFP-Hs00173490 i A |
Sortware EEEEEEEEE - BRICHSD0217848_rn1 A [ ]
) EEEEEEEEE r CD34-Hs00156373_m1 A -
isplays we CD9-HeD0233521 it A |
HEEEEEEE N r CDH5-Hs00174344_m1 A [ |
EEEEEEEEN
. : : r CD/O-HS00230319_m1 A -
information if “E R EEEEE == r S iz g A —]
S90S r COLIAT-Hs00164004_mi A -
you leave the I GODAT HaonEREES md 7 —
HEEEEEE .. r COMMD3-Hs00201350_m1 Al ]
cursorover EEEEEEEE= e T X =
— s T
th Il EEEEEEEEN | DD)4-HS00251850_m1 A 1
e well. - DES-Hs00157250_m1 A |
Kil 4 r DNMTSE-Hs00171676_m1 A |
v r EBAF-Hs00745761 51 A -
= r EEF1A1-He007 12743 s A -
Table Settings: [None ) | EOVES 00173872 it & ]
Posit..| Flag [_Sample Detestor Task | Fos | D | Lve | Ew | BF2[| ||~ e ™ 4 —
(AT amplel |ACTE-He00935003 i Targel all|™ FLTI-Hs00176573_m1 A [ |
A2 ampleD] |ACTC-HSODBUE3IE_m1 [Targe r FN1-Hs00277508 1 A -
A3 ampleD1 |AFP-HsOD173480_mi argel r FOXA2-HsD0232764_mf A |
Ad ampleD] _[BRICHSDU217848_mi arged r FOXD3-HsD0255287 _s1 A ]
125 ampleD][CD34-Hs001 56373, m argel ™| GABRESHsDU241453 mi A [ |
126 ampleD] (CD9-HS00233521 argel r GALHsD0544355_mi A |
A ampleD] _[COHEHS0D174344_m1 __[Targe = GAPD-Hs99999505_m1 A [ |
A8 ampleD] [CDYX2-Hs00230919_m1 arged r GATALHS00171403_mi A |
29 ampleD] [CGB-HsDU361224_gH argef r GATAG-Hs00232018_mi A [ |
A ampleD] (COL1AT-Hs00164004_mi _[Targe r E)2-He00230085_m1 A |
I ampleD] |85 He09333001_s1 ndogeno F CG-He0D174967 Tl A -
A amplel OL2A1-HsOD156568_m1  [Targel [l Ch1-Hs00172692_m1 Al [
I ampledl [COMMD3-Hs00201360_mi [Targel r D3 He00220998 _m1 A ]
I ampleD] |[CRABP2-Hs00275636_m1 _Targe r F AP-He00157674_mi A -
I ampleD] [CTNNG1-HSDO170025_m! Targs ~ GRAT-H917998 o1 A =i
I ampleD][DDYA-HS00251850_m1 argel
[a1 Amle0T DB eI 157258 o Add Detector.. | Clear || Copyto Manager
[a18 ampleD] _[DNMTSE-HS00171876_m1_Targe
[AT9 ampled| _[EBAF-HsO0P 45761 &1 arge v ||| Passive Reference: [rox =]
< R . . o » I~ Omit Well(s)
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The Array Information CD is shipped with your TagMan Array card. It includes the
following files:

* SDS Setup File (this page)

* Array Map File (page 27)

* Assay Information File (AIF) (page 27)

* readme text file

+ PDF file of this guide, the TagMan ®Array Micro Fluidic Cards User Guide

» PDF file of the Applied Biosystems 7900HT Fast Real-Time PCR System and SDS
Enterprise Database User Guide

The SDS Setup File is a text file (*.txt) included on the Array Information CD. The SDS
Setup File contains information specific to your TagMan Array card, such as
detector/reporter and task information for each well.

When you set up the SDS plate document for your TagMan Array card in the SDS
software, Applied Biosystems recommends that you import the SDS Setup File (see
step 4 under “Set Up the SDS Plate Document” on page 46). The SDS software uses the
information in the SDS Setup File to configure the plate grid and setup table in the SDS
plate document. The figure below shows an SDS plate document after an SDS Setup File
has been imported.

IMPORTANT! Modifying the contents of the SDS Setup File can corrupt the file, making
the file unusable (that is, you will not be able to access information for the TagMan Array
card).

& Untitled 1 - Relative Quantification =18l
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Array Information CD

Array Map File

Contents An Array Map File contains two color-coded maps that show the position of the assays on
the TagMan Array card. The top map shows the replicate distribution of assay gene
symbols for each well. The bottom map shows the TagMan Gene Expression Assay ID
numbers.

Array Map Files also indicate the:

* TagqMan Array card configuration and part number.

* Production number of the TagMan Array card. Each TagMan Array card is assigned
a unique production number. This number appears as part the AIF, Array Map File,
and SDS Setup File names.

Formats Each Array Information CD contains two Array Map Files, one in HTML format, and the
other in spreadsheet format.

To... open... using...
View a map <prodNum>*_cardmap.html your web browser.
Print a map <prodNum>*_cardmap.xls Microsoft® Excel® software.

T Where <prodNum> is the production number of the TagMan Array card.

Assay Information File (AIF)

About the AIF  The Assay Information File (AIF) is a text file that describes the TagMan Array card:
AIF_ProdNum txt

where ProdNum is the manufacturing production number

To view the AIF as a spreadsheet in Microsoft® Excel® Software:
1. Load the Array Information CD into the CD drive.
2. Navigate to the drive that contains the Array Information CD.

3. Click, then right-click ATF_ProdNum.txt, then select Open with Excel.

Notes
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Chapter 2 Order the TagMan® Array Micro Fluidic Card
Array Information CD

The table below describes the columns of the AIF.

Note: In the table below, “N/A” appears in the Example column for fields that do not

apply to TagMan Array cards.

Field name Description of content Example
Customer Name Your organization or institution University XYZ
(Sales) Order Number A unique number that identifies the Applied Biosystems sales 1234567890

order
Ship Date The date when the assay was packaged for shipment N/A
Delivery Number A unique bar code number that identifies the shipment N/A
(Shipment ID) . . .
Note: The shipment ID also appears in the plate ID.
Part Number A number that identifies the product line 4331182
Product Type The Applied Biosystems product line associated with the assay TagMan® Gene Expression
Assays
Assay ID An alphanumeric string that identifies the assay Hs00154374_m1
Lot Number A unique alphanumeric string that identifies the manufacturing A3579

batch to which the assay belongs

Shipping Rack or

The type of container in which the assay is shipped (such as a

384-well, 8-port Micro-

Plate Type 96-position or a 16-position tube rack) Fluidic Card

Shipping Rack or A bar code number on the label of each shipped rack or plate N/A

Plate ID that consists of the shipment ID plus a unique numeric suffix that
identifies the rack or plate containing the assay.

Vial/Tube Type The type of vial or tube that contains the assay N/A

Vial/Tube ID A unique, 10-digit bar code number on the bottom of each assay | N/A
vial or tube that identifies it

Well Location on the The location of the assay on the associated shipping rack or Al

Shipping Rack or Plate plate

Assay Mix The concentration of the assay, including both primers and 2X

Concentration probe

Forward Primer Name The name of the forward primer, assigned by the design N/A
software, that consists of the assay ID plus an “F” suffix

Forward Primer The nucleotide sequence of the forward primer N/A

Sequence

Forward Primer The concentration of the forward primer (uM) 18

Concentration

Reverse Primer Name The name of the reverse primer, assigned by the design N/A
software, that consists of the assay ID plus an “R” suffix

Reverse Primer The nucleotide sequence of the reverse primer N/A

Sequence

Reverse Primer The concentration of the reverse primer (UM) 18

Concentration

Notes
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Field name Description of content Example
Reporter 1 Name The name of the reporter 1 oligonucleotide probe, assigned by N/A
the design software, that consists of the assay ID and a suffix
code (M1 or M2). The letter in the suffix code identifies the
reporter dye that is covalently bound to the fluorogenic probe.
The number identifies the DNA strand used to design the probe:
e 1 - Forward strand design
e 2 — Reverse strand design
For example, in the name “KR14TD-A22TM1,” the letter “M”
indicates that the probe is labeled with the FAM™ dye, and the
number “1” indicates that the probe was designed to the
forward strand.
Reporter 1 Dye The reporter dye label for the reporter 1 probe FAM™
Reporter 1 Sequence The nucleotide sequence of the reporter 1 probe N/A
Reporter 1 The concentration of the reporter 1 probe (uM) 5
Concentration
Reporter 1 Quencher The quencher used for reporter 1 probe (for example, Minor NFQ
Groove Binder-Non Fluorescing Quencher [MGB-NFQ])
Reporter 2 Name Not applicable to TagMan® Gene Expression Assay. N/A
Reporter 2 Dye
Reporter 2 Sequence
Reporter 2
Concentration
Reporter 2 Quencher
Context Sequence The 25-nucleotide sequence surrounding the probe, including AGGAAACGTCTGGGCGAT
the targeted exon(s) GACAACC
Design Strand Indicates the strand used to design the probe: N/A

e Forward — The probe binds to the same strand as the forward
primer.

¢ Reverse — The probe binds to the same strand as the reverse
primer.

Category The Celera Panther Protein Classification (Level 1) for the gene Nucleic acid binding
Category ID A unique, 10-character alphanumeric abbreviation of the NUC 1090000
Panther category classification for the assay
Group The Celera Panther Protein Classification (Level 2) for the gene Replication origin binding
protein
Group ID A unique, 10-character alphanumeric abbreviation of the 1090300000
Panther group classification for the assay
Gene Symbol The Entrez Gene symbol for the gene CDC6
Gene Name The Entrez Gene name for the gene Cell division cycle 6
homolog (S. cerevisiae)
Chromosome The chromosome containing the gene 17
Species The organism for which the assay was designed Homo_sapiens

Target Exons

The public accession number(s) of the exon(s) that are spanned
by the probe

2

Notes
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Field name Description of content Example

NCBI Gene Reference The NCBI transcript identification number that corresponds to NM_001254.3, U77949.1,

the gene AF022109.1, CR598029.1,
BC025232.1

NCBI SNP Reference Not applicable to TagMan® Gene Expression Assays. N/A

Medline Reference PubMed references for the gene N/A

Celera ID The unique Celera Discovery System (CDS) assay identification hCT1643963.2,
number for the gene hCT2294847.0

Cytogenetic Band The chromosomal band where the gene is located. If 17921.3

unavailable, then the chromosome number is provided.

SNP Type Not applicable to TagMan® Gene Expression Assay. N/A

Minor Allele Frequency
- Caucasian

Minor Allele Frequency
-African-American

Minor Allele Frequency
-Japanese

Minor Allele Frequency
-Chinese

Celera Assembly Build
Number

Location on Celera
Assembly

NCBI Assembly Build
Number

Location on NCBI
Assembly

Notes
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Prepare Your Samples

This chapter covers:
B Prepare Your Samples. .. ...t 32
B Store the cDNA Samples . ... ..o e 34
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Prepare Your Samples

Isolate total RNA from your

samples (this page)

v

Evaluate the RNA (page 33).

v

Perform reverse transcription (RNA to
cDNA) (page 34).

RNA Template
Guidelines

Isolate Total RNA

Notes
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Note: When preparing your samples, see the product part numbers and sizes under “For
Preparing Your Samples” on page 60.

For optimal performance, Applied Biosystems recommends using RNA with the
following characteristics:

* Between 0.002 and 0.2 pg/uL in concentration of RNA

* Less than 0.005% of genomic DNA by weight

» Free of inhibitors of reverse transcription and PCR

* Dissolved in PCR-compatible buffer

* Free of RNase activity

Note: If you suspect that the RNA contains RNase activity, add RNase inhibitor to
the reverse transcription reaction at a final concentration of 1.0 U/uL. It is not
necessary to add RNase inhibitor to the reverse transcription reaction if the RNA
was purified using the ABI PRISM® 6100 Nucleic Acid PrepStation and Applied
Biosystems nucleic acid purification reagents.

* Nondenatured

Note: It is not necessary to denature the RNA. Denaturation of the RNA my reduce
the yield of cDNA for some gene targets.

To isolate total RNA from cellular samples, Applied Biosystems recommends the
TagMan® Gene Expression Cells-to-C Kit. For procedures, refer to:

www.ambion.com.

Note: The Cells-to-C Kit includes the reverse transcription (RNA to cDNA) step. If you
use this kit, it is not necessary to evaluate the RNA (page 33).
Ambion RNA Isolation Decision Tree

For other recommendations on isolating total RNA, refer to the Ambion RNA Isolation
Decision Tree:

www.ambion.com/techlib/trees/RNA/index.html

TagMan® Array Micro Fluidic Cards User Guide
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Evaluate the RNA  Use high-quality RNA that is free of contaminants (for example, proteins or detergents).
You can:
* Maeasure the UV absorbance (A,4)/A,g0) to determine both quality and quantity.
* Run an agarose gel to control the quality of 18S and 28S RNA.
* Measure the RNA Integrity Number (RIN).

Detection of genomic DNA During Amplification

When you perform the experiment (Chapter 4), the TagMan® Gene Expression Assay
used in the TagMan Array card may or may not detect genomic DNA. The suffix of the
assay ID indicates the assay placement (and thus, potential genomic DNA interference),
as described below.

Suffix Description
_m The assay’s probe spans an exon junction. The assay does not detect genomic
DNA.
_S The assay’s primers and probe are designed within a single exon. The assay

detects genomic DNA.

Note: For _s assays, Applied Biosystems recommends that you take precautions
to exclude genomic DNA from your RNA samples. You can perform an RT-minus
experiment with the TagMan Gene Expression Assay to test for genomic DNA
contaminants.

g The assay may detect genomic DNA. The assay’s probe may span an exon
junction or the assay’s primers and probe may be within a single exon.

Note: For _g assays, Applied Biosystems recommends that you take precautions
to exclude genomic DNA from your RNA samples. You can perform an RT-minus
experiment with the TagMan Gene Expression Assay to test for genomic DNA
contaminants.

_mH The assay detects transcripts belonging to a gene family with high sequence
homology. The assay provides between 10 C; and 15 C; difference between the

_SH target gene and the gene with the closest sequence homology. Therefore, the
assay detects the target transcript with 1000- to 30,000-fold greater

_gH discrimination (sensitivity) than the closest homologous transcript, if both

transcripts are present at the same copy number in a sample.
e The _gH assay may detect genomic DNA.

e The _mH assay does not detect genomic DNA.

e The _sH assay detects genomic DNA.

u The assay’s amplicon spans an exon junction, and the probe sits completely in
one of the spanned exons. The assay does not detect genomic DNA.

_ft The assay detects fusion transcripts that result from chromosomal translocation.
The probe and one primer are on one side of the fusion transcript breakpoint; the
second primer is on the other side of the fusion transcript breakpoint. The assay
does not detect genomic DNA.

_at The assay is designed to detect a synthetic RNA transcript with a unique
sequence that lacks homology to currently annotated biological sequences.

Notes
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Perform Reverse To perform reverse transcription (convert total RNA to cDNA), Applied Biosystems
Transcription recommends one of the kits listed below. For information, refer to the applicable kit

protocol.
Kit Considerations Protocol
High Capacity ¢ Reaction components are premixed High Capacity RNA-to-
RNA-to-cDNA (2 tubes), allowing for fewer pipetting cDNA Kit Protocol
Kit steps:

— 20X Enzyme Mix, containing MuLV
Reverse Transcriptase and RNase
Inhibitor Protein

— 2X RT Buffer, containing dNTP Mix,
oligo d(T) primers, and random primers

¢ Short reaction time (0.5 to 1 hour)

High Capacity ¢ Asingle tube of reagents streamlines the High Capacity RNA-to-
RNA-to-cDNA workflow and reduces experimental cDNA Master Mix
Master Mix variability Protocol

e 5X master mix. The RNA can be up to
80% of the final reaction volume.

High Capacity Reaction components are individually High-Capacity cDNA
cDNA Reverse available (4 tubes): Reverse Transcription
Transcription Kit | | 10X RT Buffer Kits Protocol

e 25X dNTP Mix
e 10X RT Random Primers
e MulLV Reverse Transcriptase

IMPORTANT! When performing reverse transcription:

* Do not exceed the amounts of total RNA recommended in the protocol.

» To avoid introducing a 3’ bias and adversely affecting the TagMan Array card
results, do not use any RT kits that use oligo d(T) primers exclusively.

Store the cDNA Samples

If you will not be using the cDNA samples immediately, store the samples at
-15 to —25 °C.

To minimize repeated freeze-thaw cycles of cDNA, Applied Biosystems recommends
that you store your cDNA samples in aliquots.

Notes
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This chapter covers:

B Prepare the TagMan® Array Micro Fluidic Card .. ........................ 36
B Run the TagMan® Array Micro Fluidic Card . .. .......................... 46
B Analyze the Experiment . . ......... ... .t 50
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Prepare the TagMan® Array Micro Fluidic Card

Prepare the PCR reaction > Fill the TagMan Array »| Centrifuge the TagMan »| Seal the TagMan Array
mix (cDNA + master mix) card with the reaction mix Array card (page 39). card (page 42).
(this page). (page 37).

Note: When preparing the TagMan Array card, see the product part numbers and sizes
under “For Preparing the TagMan® Array Micro Fluidic Card” on page 61.

Recommended For the amplification (PCR) reactions, Applied Biosystems recommends that you use:

Amounts of cDNA * 30 to 1000 ng (0.3 to 10 ng/uL) of cDNA (converted from total RNA) per fill
reservoir. The amount to use depends on the expression level of your target genes
and the number of target copies per well that you need to detect. For example, you
can use:

— 1000 ng (10 ng/uL) per fill reservoir to detect genes with low expression.
However, the cDNA concentration will be high (10 ng/uL); be sure to use high-
quality cDNA without inhibitors.

— 100 to 200 ng per fill reservoir to detect genes with moderate expression.
— 30 to 50 ng per fill reservoir to detect genes with moderate to high expression.
* The same amount of cDNA sample for all reactions.

Prepare the PCR CHEMICAL HAZARD. TagMan® Universal PCR Master Mix may
Reaction Mix cause eye and skin irritation. Exposure may cause discomfort if swallowed or inhaled.
Read the MSDS, and follow the handling instructions. Wear appropriate protective
eyewear, clothing, and gloves.

AWARNING CHEMICAL HAZARD. TagMan® Gene Expression Master Mix is

harmful if swallowed. Causes eye, skin, and respiratory tract irritation. Read Material
Safety Data Sheet and follow the handling instructions. Wear protective eyewear,
clothing, and gloves and use with adequate ventilation.

1. For each sample, determine the total number of reservoirs to be filled, based on the
format of your TagMan Array card.

Notes
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2. Per the table below, calculate the total volume required for each reaction component:
volume for 1 fill reservoir X the total number of fill reservoirs per sample

Include 12.5% excess volume in your calculations to compensate for the loss that
occurs during pipetting.

Volume (pL) for

Reaction Component 1 Fill Reservoir

cDNA sample (30 to 1000 ng?) + nuclease-free water 50.0
TagMan® Gene Expression Master Mix 50.0
or

TagMan® Universal PCR Master Mix (with or without
AmpErase® UNG)

Total Volume 100.0

I Each sample-specific PCR reaction mix should contain 30 to 1000 ng (0.3 to 10 ng/uL) of total
RNA converted to cDNA. The amount of cDNA to add depends upon the abundance of the
specific gene transcript.

3. If frozen, thaw the cDNA samples on ice. Resuspend the cDNA samples by
inverting the tube, then gently vortexing.

4. Mix the master mix thoroughly by swirling the bottle.

5. For each sample, label a 1.5-mL microcentrifuge tube, then add the required
components to the labeled tube.

6. Cap the microcentrifuge tubes, then gently vortex the tubes to thoroughly mix the
solution.

7. Briefly centrifuge the tubes to spin down the contents and eliminate air bubbles.

Fill the TagMan  Guidelines to ensure optimal PCR performance
Array Card

Do not remove a TagMan Array card from its packaging until the packaging has
reached room temperature and you are ready to fill it with sample-specific PCR
mix. Prolonged exposure to indoor lighting can photo-degrade the fluorescent
probes contained within the card. Do not expose the card to sunlight.

* Fill each fill reservoir with sample-specific PCR mix made from a single cDNA
sample.

* Add 100 puL of the sample-specific PCR mix per fill reservoir to ensure adequate
filling. Volumes smaller than 100 uL will result in insufficiently filled cards.

* Do not add sample after centrifuging the cards. When you centrifuge the card, the
sample-specific PCR mix resuspends the dried TagMan® probes and primers within
the wells of the card. Adding sample after centrifuging disrupts the resuspended
assay positions.

» To ensure a high degree of reproducibility, Applied Biosystems recommends
scheduling your runs so that each card is run as soon as possible. After sealing, there
is no measurable well-to-well contamination for up to 64 hours.

* Applied Biosystems recommends that you run replicate PCR reactions. Refer to the
TagMan® Gene Expression Master Mix Protocol, Appendix B.

Notes
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Fill the TagMan Array card

1.

Allow the TagMan Array card to reach room temperature, then carefully remove it
from its packaging.

Note: A minimum of 15 minutes at room temperature is required to equilibrate the
card.
Place the TagMan Array card on a lab bench, with the foil side down.

Load 100 pL of the desired sample-specific PCR reaction mix into a 100-uL
micropipette.

Hold the micropipette in an angled position and place the tip in the fill port.

Note: There is a fill port on the left arm of each fill reservoir; it is the larger of the
two holes.

Fill port

Vent port

GR2158

IMPORTANT! Do not allow the tip to contact and possibly damage the coated foil
beneath the fill port.

Dispense the sample-specific PCR reaction mix so that it sweeps in and around the
fill reservoir toward the vent port.

IMPORTANT! Pipette the entire 100 UL into the fill reservoir. Be careful when
pushing the micropipette plunger to its second stop position (to expel the sample-
specific PCR reaction mix from the tip). If a large amount of air is released, it can
push the reaction mix out of the fill reservoir via the vent port or introduce bubbles
into the fill reservoir.
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Centrifuge the  After the fill reservoirs have been filled with the sample-specific PCR reaction mix,
TagMan Array centrifuge the TagMan Array card to distribute the reaction mix to the reaction wells.
Card

IMPORTANT! You must use a Sorvall® or Heraeus centrifuge with the Sorvall/Heraeus
Custom Buckets and card holders. The Custom Buckets and card holders are custom-
made for the TagMan Array cards. Do not use any other centrifuge or bucket/card holder
system for this procedure. For more information, refer to the user manual for your
centrifuge.

Note: The Sorvall and Heraeus centrifuges have either a touchpad control (EASY Set
models) or knob-operated control panel (QUIKSet models). Both centrifuges use the
same bucket type and card holder.

1. Place TagMan Array cards into the Sorvall/Heraeus buckets:

a. Obtain an empty Sorvall/Heraeus Custom Bucket and card holder.

Note: The centrifuge holds four Sorvall/Heraeus buckets. Each bucket holds
up to three TagMan Array cards (loaded and/or blank balance cards) in the card
holder. The card holder supports the TagMan Array card during centrifugation.

b. Place the bucket on a lab bench, with the label facing you.

c. Insert TagMan Array cards into the card holder, making sure that:
 The fill reservoirs project upwards out of the card holder.
* The reaction wells face the same direction as the “This Side Out” label.

* You use blank balance cards to fill any open positions in the card holder.
Use the blank balance cards provided with the installation Kkits.

IMPORTANT! Be sure to use the blank balance cards to fill any open positions.
The blank balance cards will balance the centrifuge and prevent damage to the
card holder. If the card holder is not completely filled, the TagMan Array card
may become displaced during centrifugation, resulting in uneven filling.

GR2155

Notes
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d. Place a filled card holder in the bucket so that the “This Side Out” label faces
the front of the bucket.

Notes
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Sorvall emblem
here

2. Set the centrifuge:

a. Power on the centrifuge.

b. Use the front panel controls to set the bucket type to 15679.

IMPORTANT! To ensure that the maximum rotational speed stays within the
manufacturer’s specified limits, be sure to set the correct bucket type.

c. Use the front panel controls to set the following operations parameters:

Parameter EASYSet (touchpad) (kn o%?;';gf;t ed)
Up ramp rate 9 3
Down ramp rate 9 N/A
Rotational speed 1200 rpm (331 x g) 1200 rpm
Centrifugation time 2 x 1 min 2 x 1 min

TagMan® Array Micro Fluidic Cards User Guide
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EASYSet control panel rpm Scroll
indicator  control

Buttons 1-4 are
programming — *

buttons. . ‘
Down ramp

rate control rpm Time
controls controls
Up ramp
rate control Bucket type
QUIKSet control panel rpm Adjustment Adjustment
indicator knob (speed) knob (time)

Acceleration
settings

Bucket ‘
number Mode settings

3. Place the buckets into the centrifuge:

a. Press the Open button on the centrifuge to open the centrifuge cover.

Open cover button

b. Place each loaded bucket onto an open rotor arm of the centrifuge. Make sure
each bucket can swing easily within its slotted position on the rotor arm.

IMPORTANT! The manufacturer recommends running the centrifuge with all
four buckets. If the buckets are not fully loaded with TagMan Array cards
containing the sample-specific PCR reaction mix, place blank balance cards
and card holders into the buckets. Make sure the buckets and their contents are
balanced; opposing buckets should have matching weights.

Notes
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c. Close the centrifuge cover.

4. Run the centrifuge:

a. Press the Start button. The centrifuge starts, then automatically stops after
1 min, per the programmed sequence.

START button——+ .

b. Repeat step a so that the TagMan Array cards are centrifuged for a total of two
consecutive, 1-minute spins.

IMPORTANT! To ensure complete distribution of the PCR reaction mix, you
must centrifuge the TagMan Array cards for a total of two consecutive,
1-minute spins.

5. Remove the TagMan Array cards:
a. Press the Open button.

b. When the cover has fully opened, remove the buckets from the centrifuge, then
remove the card holders from the buckets.

c. Remove all TagMan Array cards from the buckets by gently lifting them by
their carrier sides.

6. Examine the TagMan Array cards to be sure filling is complete. The amount of PCR
reaction mix remaining in the fill reservoirs should be consistent from reservoir to
IeServoir.

Seal the TagMan  The TagMan® Array Micro Fluidic Card Sealer isolates the wells of a TagMan Array card
Array Card after it is loaded with PCR reaction mix. The sealer uses a precision stylus assembly
(carriage) to seal the main fluid distribution channels of the TagMan Array card.

IMPORTANT! Proper operation of the sealer using a slow, steady, and deliberate motion
is critical to the successful use of the TagMan Array card.

Notes
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1. Position the sealer:

a. Place the sealer on a sturdy lab bench, approximately waist high so that it can
be easily used.

b. Turn the sealer so that the front end (the “starting position” shown below) is
closest to you and the back end is farthest from you. In the correct position, the
arrows on the sealer are pointing away from you.

Carriage

Starting
position

c. Place the sealer’s carriage in its starting position.

IMPORTANT! Never insert a TagMan Array card into the sealer if the carriage
is not in its starting position. The TagMan Array card will be irreparably
damaged if the carriage is moved across it toward its starting position.

2. Insert a TagMan Array card into the sealer:

a. Orient the TagMan Array card in the proper direction over the sealer’s insert
plate. The card’s fill reservoir end should be the end closest to the arrows
etched in the base of the sealer.

b. Line up the card’s rear pin grooves, foil side up, to the stylus pins on the sealer.

Spring clips

Stylus pins

0 \/\\\/\\\\ \
‘\' /\(\ \
\ \// \\‘

GR2174
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c. Gently place the card on top of the insert plate and ensure that the front end of
the card is held securely in place by the spring clips.

d. Gently push the card until it is seated securely in the insert plate.
Note: When properly seated, the TagMan Array card’s foil surface should be

level with the base of the sealer. The four spring clips ensure that the card is
held in the proper position.

3. Push the carriage across the base of the sealer in the direction of the arrows. Use a

slow, steady, and deliberate motion to push the carriage across the entire length of
the TagMan Array card until the carriage reaches the mechanical stops. It is
important to avoid moving the carriage rapidly across the card.

ACAUTION The sealer has mechanical stops at both ends to prevent the

carriage from coming off. Therefore, do not use excessive force or speed when
pushing the carriage.

End position

Move in this direction: /

IMPORTANT! Do not move the carriage back before removing the TagMan Array
card.

. Remove the sealed TagMan Array card by grasping its sides and lifting it off the

sealer’s insert plate. In the middle of the sealer’s insert plate, there is a thumb slot to
help you easily access one side of the card.

Thumb slot
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5. Inspect the TagMan Array card for proper sealing. The indentations from the stylus
assembly should match up with the card’s main channels. If the indentations do not
match up or if the foil is in any way damaged, do not use the TagMan Array card.

6. Using scissors, trim the fill strip from the TagMan Array card. Use the edge of the
card’s carrier as a guide.

A (L\UI[e]M] PHYSICAL INJURY HAZARD. Take care when trimming off

the fill strip. Use scissors rather than razor blades or other unprotected cutting
devices.

(5

i
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Run the TagMan® Array Micro Fluidic Card

In the SDS software, set up the experiment (SDS plate
document), using the SDS Setup File included on the
Array Information CD (this page).

v

Perform the run on a 7900HT Fast System (page 48).

Note: When running the TagMan Array card, see the product part numbers under “For
Running and Analyzing the TagMan® Array Micro Fluidic Card” on page 62.

About Running  After the TagMan Array cards have been loaded and sealed, they are stable for at least
Multiple Cards 64 hours. Therefore, for high-throughput TagMan Array card processing, you can use the
Automation Accessory. For information on the Automation Accessory, refer to the
Applied Biosystems 7900HT Fast Real-Time PCR System and SDS Enterprise Database
User Guide.

Set Up the SDS 1. Start SDS Software v2.1 or later.

Plate Document
2. Select File » New.

3. Complete the New Document dialog box:

a. From the Assay dropdown menu, select AAC (RQ) or Relative
Quantification.

b. From the Container dropdown menu, select 384 Wells TagqMan Low Density
Array.

c. Complete the remaining fields as shown, then click OK.

New Document 3 The Assay field selections

vary, depending on your

Assay. [nact (R

—t1 software version.
Container: |384 ‘Wells Tagman Low Density Array j
Template: |Ei|ank Template j

Erowse...

Barcode: | (Recommended) Click the
Barcode field, then scan or
type the barcode.

il 7 Save Seftings &s My Default Ok | Cancel |

4. Import the SDS Setup File (*.txt) into the new SDS plate document:

a. In the CD drive, insert the Array Information CD that shipped with your
TagMan Array card.

b. In the SDS software, select File » Import.

Notes
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c. In the Import dialog box, navigate to the SDS Setup File for your TagMan
Array card, then click Import. The SDS software imports information from the
SDS Setup File into the SDS plate document.

Note: The SDS software uses the information from the SDS Setup File to
automatically configure the plate grid and setup table with detector, detector
task, marker, and sample data. For details on the SDS Setup File, see page 26.

IMPORTANT! Modifying the contents of the SDS Setup File can corrupt the
file, making the file unusable (that is, you will not be able to access
information for the TagMan Array card).

Elim port @

|@ Custom Taghlan Lowe Density Array j m

Laok in:

File name: |Sample TLDA, Setup File txd Impart
Files of type: |Tab-de|im'rted Text (*1xt) ﬂ Cancel

5. Save the SDS plate document:
a. Select File » Save As.
b. Navigate to a save location.
c. Enter a name for the SDS plate document.

d. For Files of Type, select SDS 7900HT Document (*.sds) or SDS 7900HT
Template Document (*.sdt).

Note: You can save the plate document as an SDS plate document (*.sds) or
SDS template (*.sdt). Saving the plate document as an SDS template is
recommended when you want to create duplicate plate documents for a series

of TagMan Array cards with identical assay configurations. For more
information on SDS templates, refer to the SDS Online Help.

e. Click Save.

Notes
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A TagMan® Array Micro Fluidic Card Thermal Cycling Block must be installed on the
instrument. For more information, see “Instrument Overview” on page 5.

A (.\I[el\] Surface may be hot.

. Open the SDS plate document in the SDS software.
. Select the Instrument tab.

. Use the default thermal cycling conditions, as shown in the Thermal Cycler tab.

Note: When you selected 384 Well TagMan Low Density Array (step 3 on page 46),
the SDS software automatically set the appropriate thermal cycling conditions for
the TagMan Array cards.

. Select the Real-Time tab, then verify that ERcemamawreerme]) is displayed in the status

bar. If the software is not connected to the instrument, click Connect to
Instrument.

. If the instrument tray is inside the instrument, click Open/Close to rotate the

instrument tray to the OUT position.

. Verify that the TagMan Array Micro Fluidic Card Thermal Cycling Block is

installed in the instrument tray. If the block is not installed, you must:
* Remove the existing block.
* Install the TagMan Array Micro Fluidic Card Thermal Cycling Block.
» Change the plate adapter.

For detailed information on changing the instrument blocks, refer to the
Applied Biosystems 7900HT Fast Real-Time PCR System Maintenance and
Troubleshooting Guide.

. Place the prepared TagMan Array card in the instrument tray with:

* Well Al at the top left corner of the tray and the notched corner at the top right.
* The barcode toward the front of the instrument.

TagMan® Array Micro Fluidic Cards User Guide



Chapter 4 Perform the Experiment
Run the TagMan® Array Micro Fluidic Card

Well A1

Notched
corner

Barcode

8. Click Start Run. The instrument tray rotates to the IN position. During the run, the
instrument displays real-time status information in the Instrument » Real-Time tabs
and records the fluorescence emissions. During the run, you can view the data (as
the data are generated in real-time).

9. When the Run Complete dialog box appears, click OK to close the dialog box, click
Open/Close, then remove the TagMan Array card from the instrument tray.

Notes
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Analyze the Experiment

v

Review the results (this page). (Optional) Perform downstream analysis (page 51).

Note: When analyzing the experiment, see the product part numbers under “For Running
and Analyzing the TagMan® Array Micro Fluidic Card” on page 62.

The comparative C; (AACy) method uses arithmetic formulas to determine change in
expression of a target in an experimental sample relative to the same target in a reference
sample. The AAC method is used for high-throughput measurements of relative gene
expression when there are many genes in many samples.

For details on how to analyze AAC experiments and set up an RQ Study, refer to the
7900HT Fast Real-Time PCR System Relative Quantitation Using Comparative C
Getting Started Guide. Review the chapter on analyzing and viewing RQ Study data in
the RQ Manager. Brief procedures are provided below.

Review the 1. Transfer the SDS plate document file (*.sds) into an RQ Study, then analyze the
Results study. For optimal results, Applied Biosystems recommends the following:

» For Applied Biosystems TagMan master mixes, analyze the study with
Automatic Baseline and Manual C; set to 0.2.

* View the amplification plot, then review the baseline and threshold settings. If
needed, adjust the baseline and threshold settings for individual assays.

IMPORTANT! The same threshold setting must be used for an assay across all
samples or TagMan Array cards within a study.

Note: You can use either TagMan Universal PCR Master Mix or TagMan Gene
Expression Master Mix in your experiment. However, Applied Biosystems
strongly recommends that you use only one type of master mix per study.

2. In the well table or results table, review the C values for each well and for each
replicate group. If needed, omit outliers.

Notes

50 TagMan® Array Micro Fluidic Cards User Guide



Chapter 4 Perform the Experiment 4
Analyze the Experiment

3. Review the gene expression plot (for SDS Software v2.3, view the amplification
plots in the Plate, Detector, or Sample view).

Note: Relative gene expression measurements within and across manufacturing lots of
TagMan Array cards are reproducible. You can compare normalized data (AC; values),
but not raw Cy values.

IMPORTANT! If you are using different lots of TagMan Array cards with the same set of
assays, be sure to use the correct SDS Setup File. Different lots with the same set of
assays may ship with different SDS Setup Files.

Optional) For further data analysis, the raw C and the AC values can be exported. If you are using
p T T
Perform SDS Software v2.3, you can export the values from the Plate Centric view.

DOWR?‘::IG asl;g For detailed downstream analysis, Applied Biosystems recommends the Real-Time
y StatMiner " Software. For information, refer to:
www.integromics.com/StatMiner.php
Notes
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Appendix A

Troubleshooting

The following table lists some possible errors, possible causes, and recommended

actions.

Observation

Possible Cause

Recommended Action

After removing the TagMan® Array Micro Fluidic Card from its packaging...

Water condenses on the reaction
wells (optical side of the TagMan
Array card).

The TagMan Array card may not
have come to room temperature
before being removed from its
packaging.

Remove condensation by lightly
blowing on the reaction wells. You can
use room temperature pressurized
nitrogen or an air blower.

IMPORTANT! Be sure to remove all
water condensation. The exterior
surface of the reaction wells (optical
side of the TagMan Array card) must be
free of water condensation.

After pipetting...

Too little PCR reaction mixture has
gone into the fill reservoir.

Some of the PCR reaction mixture
leaks out of the vent port in the fill
reservorr.

The PCR mixture was not correctly
pipetted into the fill reservoir.

Take care to correctly pipette the entire
PCR reaction mixture (100 pL) into the
fill reservoir. Add more sample.

Bubbles introduced into fill ports.

Air was introduced from pushing the
pipette plunger in to its second stop
position.

Inspect the affected wells after
centrifuging and sealing the TagMan
Array card. Note wells that contain
bubbles, and delete these wells from
analysis.

TagMan® Array Micro Fluidic Cards User Guide
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Observation

Possible Cause

Recommended Action

After centrifuging...

(Rare) Reaction mix remains in a
fill reservoir.

The fill port is blocked (the fill
reservoir is defective).

Inspect the TagMan Array card for a
blocked fill port or a pinched channel. If
the fill reservoir is defective, contact
Applied Biosystems Technical Support.

Filling is incomplete or not
consistent.

Excess reaction mix in a fill reservoir

1 2 4 13 6 7 8
v @ @ 1

GR2162

Centrifuge the TagMan Array card again
for 1 minute. If the reservoir filling is still
not complete after the additional
centrifuge cycle, and you choose to
process the TagMan Array card further,
you should void the results for the
affected fill reservoir (sample).

IMPORTANT! Do not exceed 1200 rpm
or accumulated centrifugation times of
more than 3 minutes. Excessive
centrifugation speeds and times may
deform the TagMan Array card.

(Rare) A fill reservoir is completely
drained.

Some wells were not filled properly.

Fill reservoir is completely drained

B 2 4

a @

@) 1

GR2163

If you choose to process the TagMan
Array card further, you should void the
results for the affected fill reservoir
(sample).

After Run/Analysis...

Amplification Plots are noisy
across portions of the TagMan
Array card. In the Multicomponent
Plot, the FAM™ and ROX™ dye
signals are below the background
for the affected wells.

No amplification across large
portions of the TagMan Array card.
In the Multicomponent Plot, the
FAM™ and ROX™ dye signals are
below the background.

The TagMan Array card is misaligned
in the TagMan® Array Micro Fluidic
Card Thermal Cycling Block.

Check the TagMan Array card for
crushed or distorted feet. If there are
crushed feet, contact Applied
Biosystems Technical Support or
contact your Applied Biosystems Field
Applications Specialist (FAS).

No amplification. The
Multicomponent Plot shows a
rapid drop in ROX™ dye signal.

Empty wells due to improper staking.

Use a steady, even motion when using
the staker.

Notes
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Observation

Possible Cause

Recommended Action

No amplification within or across
one or more rows within a single
fill reservoir. The Multicomponent
Plot shows a rapid drop in ROX™
dye signal.

Empty wells due to improper staking.

Use a steady, even motion when using
the staker.

Empty wells due to misalignment of
the staker stylus.

If the staker stylus is misaligned,
contact your Applied Biosystems FAS.

No master mix loaded in the fill
reservoir.

Add master mix.

No ampilification or poor
amplification for a specific assay.

Low-abundance gene.

e Use more cDNA.
e Preamplify the cDNA.

The SDS v2.3 QC Flag is BPR
(Bad Passive Reference). The
Multicomponent Plot may show a
gradual drop in ROX™ dye
fluorescence.

Minor leaking from the wells due to
inadequate sealing.

Use a steady, even motion when using
the staker.

Bubbles in well(s).

Use proper pipetting techniques to
avoid introducing bubbles when loading
the fill reservoirs.

Note: To determine if the data are
usable:

¢ Inspect the Multicomponent Plot.
The FAM™ and ROX™ dye signals
should be parallel.

¢ Inspect the Amplification Plot. There
should not be any spikes or bumps in
the exponential phase where the plot
crosses the threshold. Compare the
C; values to replicate wells. If the
values are comparable, then the data
are usable; if the values are not
comparable, remove the well(s) as an
outlier.

Notes
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Observation

Possible Cause

Recommended Action

Replicates have poor precision
(the standard deviation value is
> 0.5 for assays with a C; value
that is < 30).

Individual assay performance (rising
baseline or weak amplification).

Use the manual baseline setting. Adjust
the baseline and threshold settings,
then reanalyze.

Bubbles in well(s).

e Use proper pipetting techniques to
avoid introducing bubbles when
loading the fill reservoirs.

¢ Adjust the baseline and threshold
settings, then reanalyze.

e Remove the replicate well(s) as an
outlier.

Leaky well(s) due to improper
staking. The QC Flag is BPR.

e Omit the leaky well(s) from analysis,
then reanalyze the data.

e Use a steady, even motion when
using the staker.

Not all of the card holder positions
were filled before centrifuging.

Be sure to fill all of the card holder
positions with blank TagMan Array
cards before centrifuging.

Non-validated centrifuge.

Use a Sorvall® or Heraeus centrifuge.

Non-AB master mix.

Use AB master mix.

No ampilification or poor precision
across many assays.

Non-AB master mix.

No reagent (master mix).

No sample.

Inhibitor in the sample.

Check the protocol; be sure to add the
correct amount and the correct type of
sample and master mix.

Notes
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Assays for
normalization

Appendix

To help with normalization, you can select a human, mouse, or rat endogenous control
assay from the list of inventoried endogenous controls in Table 1 below.

experimental conditions and is sufficiently abundant across all tissues and cell types

studied.

Note: Applied Biosystems recommends that you experimentally validate all candidate
genes to be used as endogenous controls.

B

TagMan® Endogenous Control Assays

A valid normalization or endogenous control is needed to correct for differences in RNA
sampling and sample variation. The ideal control is expressed consistently under

Table 1 Candidate endogenous control assays for normalization (PN 4331182)
s?rzr;)eol Gene name Human assay ID Mouse assay ID Rat assay ID
18S Eukaryotic 18S rRNA Hs99999901_s1 Hs99999901_s1 Hs99999901_s1
ACTB Actin, Beta, cytoplasmic Hs99999903_m1 MmO00607939_s1 Rn00667896_m1
B2M Beta-2-microglobulin Hs99999907_m1 = MmO00437762_m1 | Rn00560865_m1
GAPDH Glyceradehyde-3-phosphate dehydrogenase Hs99999905_m1 = Mm99999915_g1 Rn99999916_s1
GUSB Beta glucuronidase Hs99999908 m1 = MmO00446953_m1 | Rn00566655_m1
HMBS Hydromethylbilane synthase Hs00609297_m1 | Mm00660262_g1 Rn00565886_m1
HPRT1 Hypoxanthine guanine phosphoribosyl Hs99999909_m1 = MmO00446968_m1 | Rn01527840_m1
transferase 1
IPO8 Importin 8 Hs00183533_m1 MmO01255158_m1 | Not Available
PGK1 Phosphoglycerate kinase 1 Hs99999906_m1 | Mm00435617_m1 Rn00821429_g1
POLR2A | Polymerase (RNA) Il (DNA directed) Hs00172187_m1 | Mm00839493_m1 | Rn01752026_m1
polypeptide A, 220 kDa

PPIA Peptidylprolyl isomerase A Hs99999904_m1 = Mm02342430_g1 Rn00690933_m1
RPLPO Ribosomal protein, large, PO Hs99999902_m1 MmO00782638_s1 Rn01479927_g1
TBP TATA box binding protein Hs99999910_m1 | Mm00446973_m1 | Rn01455648_m1
TFRC Transferrin receptor Hs99999911_m1  MmO00441941_m1 | Rn01474695_m1
UBC Ubiquitin C Hs00824723_m1 | Mm01201237_m1 | Rn01789812_g1
YWHAZ | Tyrosine 3-monooxygenase, or tryptophan 5- Hs00237047_m1 | MmO01158417_g1 Rn00755072_m1

monooxygenase activation protein, zeta
polypeptide
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Appendix C

Required Materials

This appendix covers:

B For Preparing Your Samples . .. ... 60
B For Preparing the TagMan® Array Micro Fluidic Card .. ................... 61
B For Running and Analyzing the TagMan® Array Micro Fluidic Card .......... 62
B For General Use . ... ... it 63
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For Preparing Your Samples

Reagents
Item Size Part Number
TagMan® Gene Expression Cells-to-CT™ | 100 lysis reactions/500 PCR AM1728
Kit
400 lysis reactions/2000 PCR AM1729
High Capacity cDNA Reverse 200 reactions 4368814
Transcription Kit
200 reactions with RNase 4374966
Inhibitor
1000 reactions 4368813
1000 reactions with RNase 4374967
Inhibitor
High Capacity RNA-to-cDNA Master Mix | 200 reactions 4390778
High Capacity RNA-to-cDNA Kit 50 reactions 4387406

Notes
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For Preparing the TagMan® Array Micro Fluidic Card

Reagents
Item Size; Description Part Number
TagMan® Gene Expression Master Mix Mini-Pack; One 1-mL tube 4370048
@2X)
1-Pack; One 5-mL bottle 4369016
2-Pack; Two 5-mL bottles 4369514
5-Pack; Five 5-mL bottles 4369510
10-Pack; Ten 5-mL bottles 4369542
Bulk-Pack; One 50-mL bottle 4370074
TagMan® Universal PCR Master Mix 1-Pack; One 5-mL bottle 4304437
with AmpErase® UNG (2X)
2-Pack; Two 5-mL bottles 4364338
5-Pack; Five 5-mL bottles 4364340
10-Pack; Ten 5-mL bottles 4305719
Bulk-Pack; One 50-mL bottle 4326708
TagMan® Universal PCR Master Mix, No | 1-Pack; One 5-mL bottle 4324018
AmpErase® UNG
2-Pack; Two 5-mL bottles 4364341
5-Pack; Five 5-mL bottles 4364343
10-Pack; Ten 5-mL bottles 4324020
Bulk-Pack; One 50-mL bottle 4326614
TagMan® Array Custom Micro Fluidic One TagMan Array card; See Chapter 2
Card 384 wells per card on page 9 for
ordering
TagMan® Gene Set One TagMan Array card; information.
384 wells per card
TagMan® Gene Signature Array The endogenous control Gene
Signature Arrays come in sets of
two cards; the remaining Gene
Signature Arrays come in sets of
four cards. 384 wells per card.
Equipment
Item Part Number
Micropipettes, 100-uL Major laboratory supplier (MLS)
Sorvall® or Heraeus centrifuge Contact your local Applied
Biosystems Sales
Rotor Representative.

Notes
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Item

Part Number

Sorvall/Heraeus Custom Buckets

Sorvall/Heraeus card holders

TagMan® Array Micro Fluidic Card Sealer

Included in the 7900HT TagMan®
Array Micro Fluidic Card
Upgrade (hardware upgrade Kkit).

For Running and Analyzing the TagMan® Array Micro Fluidic
Card

Instrument and

Notes

62

Accessories

Software

Item

Part Number

Applied Biosystems 7900HT Fast Real-Time PCR System

Contact your local Applied
Biosystems Sales
Representative.

7900HT TagMan® Array Micro Fluidic Card Upgrade
(hardware upgrade kit)

This kit includes:

¢ TagMan® Array Micro Fluidic Card Thermal Cycling
Block

* TagMan® Array Micro Fluidic Card Sealer

e Four centrifuge buckets and card holders (specific to
the Sorvall® or Heraeus centrifuge)

e 7900HT TagMan® Array Micro Fluidic Card Chemical
Installation Kit:

— Spectral Calibration Kit

- TagMan® Array Micro Fluidic Card Instrument
Verification RNase P Kit

— Calibration Cards (4 cards)

4329012

Item

Part Number

SDS Software v2.1 or later

Note: SDS Software v2.1 through v2.2.2 include the
AAC+ Study program. SDS Software v2.3 includes the
RQ Manager program. Both programs are provided for
relative quantitation analysis.

Contact your local Applied
Biosystems Sales
Representative.

Real-Time StatMiner™ Software

Go to

www.integromics.com/StatMiner.php.
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For General Use

For more product recommendations, visit the real-time PCR decision tree:

www.appliedbiosystems.com/qpcrtree

Item Source
Disposable gloves MLS
Microcentrifuge MLS
Microcentrifuge tubes, 1.5-mL MLS
Nuclease-free Water (not DEPC-treated) Applied Biosystems
PN AM9930
Pipette tips, with filter plugs MLS
Pipettes, positive-displacement or air-displacement MLS
Polypropylene tubes MLS
Tris-EDTA (TE) buffer, pH 8.0 MLS
Vortexer MLS

Notes
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Appendix D

Prevent Contamination

PCR assays require special laboratory practices to avoid false positive amplifications.
The high throughput and repetition of these assays can lead to amplification of one DNA
molecule.

Good Laboratory  When preparing samples for PCR amplification:

Practices for PCR

Wear a clean lab coat (not previously worn while handling amplified PCR products
or used during sample preparation) and clean gloves.

Change gloves whenever you suspect that they are contaminated.
Maintain separate areas and dedicated equipment and supplies for:

— Sample preparation

— PCR setup

— PCR amplification

— Analysis of PCR products
Never bring amplified PCR products into the PCR setup area.
Open and close all sample tubes carefully. Try not to splash or spray PCR samples.
Keep reactions and components capped as much as possible.
Use a positive-displacement pipette or acrosol-resistant pipette tips.
Clean lab benches and equipment periodically with 10% bleach solution.
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